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Copyright Notice And Legal Disclaimer
Copyright © 2006-2009 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in part 
without permission in writing from Dialogic Corporation at the address provided below.

All contents of this document are furnished for informational use only and are subject to change without notice and do not 
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to ensure 
the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this information 
and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO LICENSE, EXPRESS OR 
IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT 
AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, 
AND DIALOGIC DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS 
INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR 
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in nuclear 
facility applications.

Due to differing national regulations and approval requirements, certain Dialogic products may be suitable for use only in 
specific countries, and thus may not function properly in other countries. You are responsible for ensuring that your use of 
such products occurs only in the countries where such use is suitable. For information on specific products, contact Dialogic 
corporation at the address indicated below or on the web at www.dialogic.com.

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, in 
marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other intellectual 
property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the sale of Dialogic 
products other than a license to use such product in accordance with intellectual property owned or validly licensed by Dialogic 
and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed information about such 
intellectual property is available from Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada 
H4M 2V9. Dialogic encourages all users of its products to procure all necessary intellectual property licenses 
required to implement any concepts or applications and does not condone or encourage any intellectual property 

infringement and disclaims any responsibility related thereto. These intellectual property licenses may differ 

from country to country and it is the responsibility of those who develop the concepts or applications to be aware 

of and comply with different national license requirements. 

Using the AMR-NB resource in connection with a Dialogic® product does not grant the right to practice the AMR-NB standard. 
To seek a patent license agreement to practice the standard, contact the VoiceAge Corporation at 
http://www.voiceage.com/licensing.php.

Dialogic, Dialogic Pro, Brooktrout, Cantata, SnowShore, Eicon, Eicon Networks, Eiconcard, Diva, SIPcontrol, Diva ISDN, TruFax, 
Realblocs, Realcomm 100, NetAccess, Instant ISDN, TRXStream, Exnet, Exnet Connect, EXS, ExchangePlus VSE, Switchkit, 
N20, Powering The Service-Ready Network, Vantage, Making Innovation Thrive, Connecting People to Information, Connecting 
to Growth and Shiva, among others as well as related logos, are either registered trademarks or trademarks of Dialogic. 
Dialogic's trademarks may be used publicly only with permission from Dialogic. Such permission may only be granted by 
Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada H4M 2V9. Any authorized use of 
Dialogic's trademarks will be subject to full respect of the trademark guidelines published by Dialogic from time to time and 
any use of Dialogic's trademarks requires proper acknowledgement. 

Microsoft, Windows, Windows Server, and Windows Vista are registered trademarks of Microsoft Corporation in the United 
States and/or other countries. The other names of actual companies and products mentioned herein are the trademarks of 
their respective owners.

http://www.voiceage.com/licensing.php
http://www.voiceage.com/licensing.php
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Software License Agreement
This Software License Agreement ("Agreement") is a legal Agreement for the conditional use of the software 

provided herein ("Program") between you, the end-user, and Dialogic Corporation ("Dialogic"). By downloading, 

copying or otherwise using the Program, you agree to be bound by the terms of the foregoing license. 

YOU ASSUME RESPONSIBILITY FOR THE SELECTION OF THE PROGRAM TO ACHIEVE YOUR INTENDED RESULTS, AND FOR 
THE INSTALLATION, USE, AND RESULTS OBTAINED FROM THE PROGRAM.

The Program may contain certain software applications and portions of applications which are provided to You under terms 
and conditions which are different from this Agreement (such as open source or community source), or which require Dialogic 
to provide Customer and its Subsidiaries with certain notices and/or information (“Excluded Code”). Dialogic will identify such 
Excluded Code in a text file or about box or in a file or files referenced thereby (and shall include any associated license 
agreement, notices and other related information therein), or the Excluded Code will contain or be accompanied by its own 
license agreement. Your use of the Excluded Code will be subject to the terms and conditions of such other license agreement 
solely to the extent such terms and conditions are inconsistent with the terms and conditions of this Agreement or are required 
by such other license agreement.  By using or not uninstalling such Excluded Code after the initial installation of the Excluded 
Code you acknowledge and agree to all such license agreements, notices and information. 

License

Under the terms and conditions of this Agreement:

• You may install and use one copy of the Program on a single-user computer, file server, or on a workstation of a local area 
network. 

• Some or all functions of the Program may be available solely if the Program is used with one or more legally acquired Dialogic 
Activation Key(s).

• To obtain an Activation Key you must first purchase a Proof of Purchase Code (PPC).  A PPC may be included in your software 
or hardware package or you may have to purchase it separately.

• You will receive your Activation Key upon registering the Proof of Purchase Code as directed in the PPC document.

• It may be possible to install multiple Activation Keys into the Program; in such a case, the total functionality provided by 
the Program will be the sum of the licensed functionalities controlled by the installed Activation Keys as long as the maximum 
capabilities of the Program are not exceeded and the functionalities are compatible.

• Your Activation Key(s) will restrict your use of the Program. At least one of the following restriction schemes will be available 
to you when you register each Proof of Purchase Code (PPC) and request an Activation Key.

• The Activation Key may be associated with a specific Dialogic hardware device. In this case, the licensed functionality 
controlled by the Activation Key will be available solely if the same Dialogic hardware is present in the computer.  You 
can move the Program to another computer solely if you move the specified Dialogic hardware to the new computer.

• The Activation Key may be associated with a specific Dialogic-supplied software protection device (‘dongle’). In this 
case, the licensed functionality controlled by the Activation Key will be available solely if the same dongle is present in 
the computer.  You can move the Program to another computer solely if you also move the dongle to the new computer.

• The Activation Key may be associated with your specific computer hardware platform. In this case, the licensed 
functionality controlled by the Activation Key will be available solely if no significant change is made to the hardware 
installed in the computer.  Replacement Activation Keys may be issued at the discretion of Dialogic solely if Dialogic can 
determine that you have not moved the Program to another computer.  Sufficient information must be provided to 
Dialogic to allow it to make that determination.

• In addition to the above restrictions, each Activation Key may have a specific term of use commencing from the date of PPC 
registration.  In this case, the licensed functionality controlled by the Activation Key will not be available after the Activation 
Key has expired.

• The Activation process requires that you enter the following information into the web-based system to obtain an Activation 
Key:

• Proof of Purchase Code (PPC)

• The Device ID provided to You by the ‘Activation’ function in the Program

• Your email address so that the Activation Key can be delivered to You by email

• Dialogic will retain the information above for the following purposes:

• Validation of future requests from You for replacement Activation Keys

• Sending renewal reminders to You in the case of limited time licenses.

• If the Dialogic hardware device that Activation Keys are associated with is judged to be defective by Dialogic following its 
standard practices, Dialogic Support will issue to You replacement Activation Keys associated with the replacement device 
upon receipt of the faulty device by Dialogic.  Replacement of the faulty device is subject to the terms of Dialogic's Hardware 
Warranty.  If a valid Advance Replacement Insurance policy is in place for the Dialogic hardware, Dialogic will endeavor to 
expedite provision of Activation Keys associated with the replacement device.
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• If the Dialogic-supplied software protection device (a ‘dongle’ or ‘USB-stick’) that Activation Keys are associated with is 
judged to be defective by Dialogic following its standard practices, Dialogic Support will issue to You replacement Activation 
Keys associated with the replacement device upon receipt by Dialogic of the failed device.  Replacement of the faulty device 
is subject to the terms of Dialogic's Hardware Warranty.

• You may copy the Program into any machine readable or printed form for backup in support of your use of one copy of the 
Program;

• You may make one copy of Dialogic’s documentation provided that all copyright notices contained within the documentation 
are retained;

• You may transfer the Program, documentation and the license to another eligible party within your Company if the other 
party agrees to accept the terms and conditions of this Agreement. If You transfer the Program and documentation You must 
at the same time either transfer all copies whether in printed or machine readable form to the same party or destroy any 
copies not transferred; 

• You may not rent or lease the Program. You may not reverse engineer, decompile or disassemble the Program. You may not 
use, copy, modify or transfer the Program and documentation, or any copy, modification or merged portion, in whole or in 
part, except as expressly provided for in this Agreement;

• You may not modify the Program in order to circumvent or subvert the protection mechanisms inherent in the program or 
attempt to use a time-limited Activation Key after it has expired;

• If You transfer possession of any copy, modification or merged portion of the Program or documentation to another party in 
any way other than as expressly permitted in this Agreement, this license is automatically terminated.

Term

The license is effective until terminated. You may terminate it at any time by destroying the Program and documentation 
together with all copies, modifications and merged portions in any form.

It will also terminate upon conditions set forth elsewhere in this Agreement or if you fail to comply with any terms or conditions 
of this Agreement at any time. You agree upon such termination to destroy the Program and documentation together with all 
copies, modifications and merged portions in any form.

Limited Warranty

The only warranty Dialogic makes, beyond the replacement of Activation Keys under the terms set out above, is that the 
medium on which the Program is recorded will be replaced without charge if Dialogic, in good faith, determines that it was 
defective in materials or workmanship and if returned to your supplier with a copy of your receipt within ninety (90) days from 
the date you received it. Dialogic offers no warranty for your reproduction of the Program. This Limited Warranty is void if 
failure of the Program has resulted from accident, misuse, abuse or misapplication.

Customer Remedies

Dialogic’s entire liability and You and Your Authorized Users exclusive remedy shall be, at Dialogic’s option, either (a) return 
of the price paid or (b) repair or replacement of the Program that does not meet the above Limited Warranty. Any replacement 
Program will be warranted for the remainder of the original Warranty period.

No Other Warranties

Dialogic disclaims all other warranties, either express or implied, including but not limited to implied warranties or 
merchantability and fitness for a particular purpose and the warranty against latent defects, with respect to the Program and 
the accompanying documentation. This limited warranty gives You specific legal rights. You may have others, which may vary 
from jurisdiction to jurisdiction.

No Liability for Consequential Damage

In no event shall Dialogic its subsidiaries, directors, employees or suppliers be liable for any damages whatsoever (including 
without limitation, damages for loss of business profits, business interruption, loss of information, or other pecuniary loss and 
indirect, consequential, incidental, economic or punitive damages) arising out of the use of or inability to use this Program, 
even if Dialogic has been advised of the possibility of such damages. As some jurisdictions do not allow the exclusion or 
limitation for certain damages, some of the above limitations may not apply to You or your Authorized Users.

Limit of Liability

The entire aggregate liability of Dialogic under any provision of this agreement shall be limited to the amount actually paid 
by You for the affected Program. Dialogic's subsidiaries, directors, employees and suppliers shall have no liability under this 
Agreement.
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Right to Audit

If this Program is licensed for use in a Company, your Company agrees to keep all usual and proper records and books of 
accounts and all usual proper entries relating to each installation of the Program during the term of this Agreement and for a 
period of three (3) years thereafter. During this period, Dialogic may cause an audit to be made of the applicable records and 
of the installations of the Program in order to verify Your compliance with this Agreement and prompt adjustment shall be 
made to compensate for any errors or omissions disclosed by such audit. Any such audit shall be conducted by an independent 
certified public accountant selected by Dialogic and shall be conducted during the regular business hours at Your offices and 
in such a manner as not to interfere with Your normal business activities. Any such audit shall be paid for by Dialogic unless 
material discrepancies are disclosed. 

For such purposes, ‘material discrepancies’ shall mean the Company exceeding by three percent (3%) or more the number 
of licensed channels for any function of the Program or the Company exceeding the licensed number of Authorized Users by 
three percent (3%) or more. If material discrepancies are disclosed, Your Company agrees to pay Dialogic for the costs 
associated with the audit as well as the license fees for the additional licensed channels or Authorized Users. In no event shall 
audits be made more frequently than semi-annually unless the immediately preceding audit disclosed a material discrepancy.

Supplementary Software

Any Supplementary Software provided with the Dialogic Program referred to in this License Agreement is provided ‘as is’ with 
no warranty of any kind.

U.S. Government Restricted Rights

The Program and documentation are provided with RESTRICTED RIGHTS.  Use, duplication or disclosure by the 

U.S. Governments is subject to restrictions as set forth in subparagraph c) 1) ii) of The Rights in Technical Data 

and Computer Software clause at DFARS 252.227-7013 or subparagraph c) 1) and 2) of the Commercial 

Computer Software-Restricted Rights at 48 CFR52.227-19, as applicable.  

Governing Law

This Agreement shall be construed and controlled by the laws in force in the Province of Quebec, Canada.

Contractor/ manufacturer is: 

DIALOGIC CORPORATION. 

9800 Cavendish Blvd., Montreal, Quebec, Canada H4M 2V9

This Agreement has been drafted in English at the express wish of the parties.  Ce contrat a été rédigé en anglais à la demande 
expresse des parties.
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About This Publication

How to use this online guide

• To view a section, click the corresponding bookmark located on the left.

• To view a topic that contains further information, click the corresponding blue underlined phrase.

• You may wish to print out the pages required for installing the drivers.

Structure of this guide

This guide provides a detailed description of how to install and configure Dialogic® Diva® softSS7 software.

This guide is structured as follows:

Section Contents

About the Dialogic® Diva® softSS7 Software Dialogic® Diva® softSS7 software features, supported Dialogic® Diva® 
Media Boards

Preparing the Dialogic® Diva® Media Boards Preparations before using the Diva softSS7 software

Installing the Dialogic® Diva® softSS7 Software Installation of the Diva softSS7 software

Software Configuration Modifications in the Dialogic® Diva® Configuration Manager, activation 
and installation of the license file

Starting the Dialogic® Diva® softSS7 Software Start and verification of the Diva softSS7 software

Tracing Creation of traces with the Dialogic® Diva® Diagnostics tool

Uninstalling Uninstallation of the Diva softSS7 software

Issues While Running the Dialogic® Diva® softSS7 
Software

How to solve problems with Diva softSS7

Glossary Explanation of the most common terms in the SS7 environment

Appendix Examples and explanations of the default Diva softSS7 configuration 
file 
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CHAPTER 1

About the Dialogic® Diva® softSS7 Software 

The Diva softSS7 software is an add-on for the Dialogic® Diva® System Release Software. The Diva softSS7 

software enables you to use your Dialogic® Diva® Media Board with Microsoft® Windows® XP, Windows Server® 

2003, Windows Vista®, Windows Server® 2008, Windows® 7 and to have connectivity over the SS7 signaling 

network and still use applications with standard programming interfaces like CAPI and SDK. 

This reference guide describes the basic Windows® configuration for the Diva softSS7 software. It is intended 

to provide advice and instructions on how to install the Diva softSS7 software modules as add-on software for 

Diva System Release Software.

Diva softSS7 software signaling features

• Basic inbound and outbound calls

• Support for ETSI (ITU-T) SS7 MTP3/ISUP protocols

• SS7 Signaling End Point (SEP) functionality

• Connection to other SEP or Signaling Transfer Point (STP)

• Associated signaling mode (SS7 link and bearer channels on same trunk)

• Quasi-associated signaling mode via STP (one or more SS7 link(s) on one or more trunk(s), bearer channels 

on different trunks) 

• User-defined trunk number(s) and 64 kbps timeslot(s) for signaling link(s)

• Up to eight E1 trunks per installation

• Up to 247 bearer channels per installation

• Up to eight linksets with up to 16 SS7 signaling links

• Support of B-channel types (speech, 3.1 kHz audio, 64 kbps transparent, Data, 3G Video GW)

• Configuration for MTP 1-3, ISUP and call control parameters per text file

• Blocking/unblocking according to ITU-T ISUP

• Disabling incoming/outgoing calls on specific channels (CICs)

• User mode management interface for all layers

• Enable dynamic change of:

• blocking states

• disabling incoming/outgoing calls

• debug mask

via user mode management interface

• Representation of layer 1 state on ISUP via blocking, e.g., if Layer 1 goes down on a trunk, the related interface 

is blocked

• Any event disabling signaling is represented on ISUP via blocking, e.g., if the signaling connection between 

the trunk card and the SS7 system service is down, the related interface is blocked

• Restricted representation of blocking state and disabling incoming/outgoing calls on specific channels via the 

Dialogic® Diva® Management tool

• 24-bit point code support as used in China
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Supported hardware

The Dialogic® Diva® softSS7 software supports the following Dialogic® Diva® ISDN Media Boards: 

Note:  "HS" stands for the half size and "FS" for the full size board format.

Diva PRI 3.0: Diva V-PRI:

• Diva PRI/E1/T1-CTI • Diva V-PRI/E1-30

• Diva PRI/E1/T1-8

• Diva PRI/E1-30

Diva Multiport PRI PCI: Diva Multiport PRI PCIe:

• Diva V-2PRI/T1-48 PCI • Diva V-1PRI/E1/T1-30 PCIe HS

• Diva V-2PRI/E1-60 PCI • Diva V-2PRI/E1/T1-60 PCIe HS

• Diva V-4PRI/T1-96 PCI • Diva V-4PRI/E1/T1-120 PCIe HS

• Diva V-4PRI/E1-120 PCI • Diva V-4PRI/E1/T1-120 PCIe FS

• Diva V-8PRI/E1/T1-240 PCIe FS
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CHAPTER 2

Preparing the Dialogic® Diva® Media Boards

To use your Diva Media Board with the Dialogic® Diva® softSS7 software, you need to install the Dialogic® Diva® 

System Release WIN Software first. You can download the files for installing the software from the following 

Dialogic web site:

http://www.dialogic.com/products/tdm_boards/system_release_software/Diva_for_Windows_2000.htm?dl=1

&regID=6628

The online Diva System Release WIN Software Reference Guide provides help for the installation of the software. 

You can download it from the following Dialogic web site: 

http://www.dialogic.com/manuals/

After the successful installation of the Dialogic® Diva® drivers, you can install the Diva softSS7 software add-on. 

See Installing the Dialogic® Diva® softSS7 Software on page 11 for more information.

http://www.dialogic.com/products/tdm_boards/system_release_software/Diva_for_Windows_2000.htm?dl=1&regID=6628
http://www.dialogic.com/manuals/
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CHAPTER 3

Installing the Dialogic® Diva® softSS7 Software

After you installed the Dialogic® Diva® System Release WIN Software as described in Preparing the Dialogic® 

Diva® Media Boards on page 10, you may install the Diva softSS7 software as described below:

1. Click Start > Programs > Dialogic Diva > Install softSS7.

2. The Diva softSS7 software welcome screen appears. Click Next to continue with the installation.

3. The End-User Licence Agreement box appears. Read the license agreement carefully. You need to accept 

it in order to install the drivers.

4. The Ready to Install box appears and displays information on the detected software. 

Click Install to install the Diva softSS7 software.

5. After the installation is complete, the Completing the Diva softSS7 for Windows box appears. Click 

Finish to complete the installation. Restart your computer if you are prompted to do so.

You can now configure the Diva softSS7 software as described in Software Configuration on page 12.
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CHAPTER 4

Software Configuration

After you installed the Dialogic® Diva® softSS7 software as described in Installing the Dialogic® Diva® softSS7 

Software on page 11, open the Dialogic® Diva® Configuration Manager to make some necessary changes.

1. Click Start > Programs > Dialogic Diva > Configuration Manager. 

2. To enable the SS7 protocol, select the line and set the property Switch Type to SS7 Net, SS7 E1 Trunk. 

Depending on your network, you can either switch CRC 4 Mode to Force ON or to Force OFF. If the network 

provides the clock for the signaling, the Operation Mode should be set to TE - Terminal Equiment 

(Recommended). Leave the rest of the settings at their default values.

3. Save your configuration. To do so, click File > Save, then go to the directory where you want to save the 

file, enter a name for the configuration file and click Save.

4. Activate your configuration. To do so, click File > Activate. Restart your PC when you are prompted to do so.

Test the Dialogic® Diva® Media Board

After the restart of the system, plug the 2MB trunk into one port of your Diva Media Board. If the red LED of 

this port is turned off, your configuration is working properly from the hardware point of view. If the red LED 

remains lit, you need to verify the configuration with help of the Dialogic® Diva® Configuration Manager or you 

need to make sure that the other end of the cable is properly connected to the end-point.

Loopback test

If your Diva Media Board has various ports or you have various Diva Media Boards installed, you can also do a 

loopback test. To do so, plug the loopback cable in the ports you want to test. If the red LED is turned off, your 

configuration is working properly on a hardware/electrical level. If they remain lit, you need to verify the 

configuration with help of the Diva Configuration Manager.
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Activate the license

If you received a Proof of Purchase Code (PPC) for the Dialogic® Diva® softSS7 software instead of a license file 

from Dialogic Corporation, you need to activate your license yourself via the Dialogic web portal.

1. Open the following web site: http://www.dialogic.com/activate.

2. Follow the instructions on the web site. 

3. If you are asked to enter your Device Unique ID (DUID), obtain this number as follows:

• Click Start > Programs > Diva softSS7 > Diva softSS7 License Manager.

• The serial number of the installed Diva Media Boards and the Device Unique ID are displayed under 

Available Licensing Entities.

4. Copy and paste the Device Unique ID from the Diva softSS7 License Manager into the web site. 

5. Follow the remaining instructions.

6. The license file will be generated and sent to the email address you entered.

Install the license file

The license file you receive as an attachment of an email looks similar to this example: 

SC71000_000093_N13ZC4VYX22PR4NHG3UVDP1T2AJ.lic

1. Copy the license file to the computer where you installed the Dialogic® Diva® softSS7 software.

2. Click Start > Programs > Diva softSS7 > Diva softSS7 License Manager. 

3. Click Open License File and go to the directory where your file is stored. Select the license file and click 

Open.

4. In the License Manager window, click Install License File to copy and install the license file into the Diva 

softSS7 software directory. 

http://www.dialogic.com/activate/akiweb_reg.asp
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5. All information regarding the license are displayed under License Information.

6. Click Quit to close the Diva softSS7 License Manager.

Change the Dialogic® Diva® softSS7 software configuration file

A default configuration file is installed with the Diva softSS7 software package. This configuration file called 

"divaSS7.cfg" is text based. You need to change the configuration file and enter your own SS7 configuration 

parameters. To do so, open the configuration file via: Start > Programs > Diva softSS7 > Edit Diva softSS7 

Configuration File. See the Appendix on page 22 for a more detailed description of this file. If the Diva softSS7 

software was configured before that update, the configuration from the former version will be loaded.
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CHAPTER 5

Starting the Dialogic® Diva® softSS7 Software

After you installed the Diva softSS7 software and the license file and made the necessary changes to the 

divaSS7.cfg configuration file, you can start the Diva softSS7 software.

1. Click Start > Programs > Diva softSS7 > Start SS7 Services.

2. If an error message appears, you might have an error in your DivaSS7.cfg configuration file or a license 

problem. Verify your configuration and license file again.

3. To stop the services, click Start > Programs > Diva softSS7 > Stop SS7 Services.

4. To see the services running, click Start > Control Panel > Administrative Tools > Services. 

5. The default start-up settings for the Dialogic Diva softSS7 services are Automatic. This means that Diva 

softSS7 software will start automatically after a restart of the system. You can change this as follows: 

• Select the service you want to change, right-click it and select Properties.

• In the windows that opens select under Startup type the type you need.

Verify if the Dialogic® Diva® softSS7 software is running

To verify if the Diva softSS7 software starts up properly, you can use the following command in a command line 

box: 

ditrace -p | find " S-"
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This command shows the start-up of MTP3 and ISUP and all signaling link status related events, for example 

when a link goes down or a point code is unreachable.
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CHAPTER 6

Tracing

With the Dialogic® Diva® softSS7 software you can collect trace information with static tracing or dynamic tracing 

as described below.

Static tracing

Trace information will be written via the standard Dialogic® Diva® trace facilities. To enable tracing for the Diva 

softSS7 software you have to make sure that you have the following entries in the "divaSS7.cfg" file:

ISUP_CC_DEBUG_MASK 0x00000007 # set to STATUS|ERROR|WARN
MTP3_MTP2_DEBUG_MASK 0x00000007 # set to STATUS|ERROR|WARN

See the Appendix on page 22 for a full description of the debug mask. If you need to make changes to the 

"divaSS7.cfg" file, you need to stop and start the Diva softSS7 software, after the configuration file is saved.

To do so, click Start > Programs > Diva softSS7 > Stop SS7 Services and then Start > Programs > Diva 

softSS7 > Start SS7 Services.

Now you can use the Dialogic® Diva® Diagnostic Tool to create a trace. See Dialogic® Diva® Diagnostics tool 

on page 18 for more information.

Dynamic tracing

With the Dialogic® Diva® softSS7 software it is possible to enable and disable tracing dynamically. You can use 

the specially provided batch files for this: setTraceMaskISUPCC.bat as shown in the first graphic and 
setTraceMaskMTP.bat as shown in the second graphic. These batch files are located under: C:\Program 
Files\Diva Server SoftSS7 
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After setting the trace masks for the ISUP and MTP processes you can use the Diva Diagnostics tool to start your 

tracing as described below.

Dialogic® Diva® Diagnostics tool

Now you can use the Diva Diagnostics tool to create a trace. To open the tool, click Start > Programs > Dialogic 

Diva > Diagnostics. If you want to trace only on SS7 level, you need to disable all other categories as shown 

below.

For more information on how to create a trace file see the Dialogic® Diva® Diagnostics Online Help file 

(DivaTrace.chm). 
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CHAPTER 7

Uninstalling

To uninstall the Dialogic® Diva® softSS7 software do the following:

1. Click Start > Control Panel > Add or Remove Programs.

2. Select the Diva softSS7 software and click Remove.

3. Your Diva softSS7 software is now uninstalled.

4. License files and configuration files are not removed. They are saved and stay in the Diva softSS7 software 

folder under C:\Program files\Diva Server SoftSS7.
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CHAPTER 8

Issues While Running the Dialogic® Diva® softSS7 Software

If you have any problems with the Diva softSS7 software, please contact Dialogic support at 

http://www.dialogic.com/support/contact/.

Note:  When contacting support, you will be asked to provide traces of your Diva softSS7 software application 

as well as of the CAPI and Dialogic® Diva® Media Board. For more information, see Tracing on page 17. 

http://www.dialogic.com/support/contact/
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Glossary

APC Adjacent Point Code

CAPI COMMON-ISDN-API: CAPI - the ISDN interface

CIC Circuit Identification Code

DPC Destination Point Code

ETSI European Telecommunications Standards Institute

ISUP ISDN User Part

ITU-T International Telecommunication Union

LPC Local Point Code this is the same as the OPC

MTP2 Message Transfer Part level 2

MTP3 Message Transfer Part level 3

OPC Originator Point Code

SDK Software Development Kit

SEP Signaling End Point

SLC Signaling Link Code

SLS Signaling Link Selection

SS7 Signaling System Number 7

STP Signal Transfer Point
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Appendix

Explanation of the divaSS7.cfg file

It is necessary to configure the Dialogic® Diva® softSS7 software via file editing. Below you find the default 

divaSS7.cfg file that is delivered with the Diva softSS7 software:

#----------------------------------------------------------------------------------
# STACK_STANDARD_TYPE : Specifies the variant of the stack 
# ITU= 1, ETSI=2
#----------------------------------------------------------------------------------
STACK_STANDARD_TYPE              1 
#----------------------------------------------------------------------------------
# NETWORK_INDICATOR : Specifies the network indicator of ISUP and MTP3 
# International 0 = 0, International 1 / SPARE = 1, 
# National 0 = 2, National 1 (Reserved for national use) = 3
#----------------------------------------------------------------------------------
NETWORK_INDICATOR                2 
#----------------------------------------------------------------------------------
# MTP3 and ISUP are communicating via (local) sockets with each other 
# -> therefore the below paragraph is required 
# MTP3_IP_ADDRESS          - IP of MTP3 
# ISUP_IP_ADDRESS          - IP of ISUP 
# MTP3_SERVER_PORT         - MTP3 server port to which the ISUP client is connecting
# ISUP_SERVER_PORT         - ISUP server port to which the MTP3 client is connecting
# MTP3_CLIENT_TO_ISUP_PORT - MTP3 client port which connects to the ISUP server
# ISUP_CLIENT_TO_MTP3_PORT - ISUP client port which connects to the MTP3 server
# all entries are required
#----------------------------------------------------------------------------------
MTP3_IP_ADDRESS                 127.0.0.1
MTP3_SERVER_PORT                13000
MTP3_CLIENT_TO_ISUP_PORT        13100
ISUP_IP_ADDRESS                 127.0.0.1
ISUP_SERVER_PORT                14000
ISUP_CLIENT_TO_MTP3_PORT        14100
#----------------------------------------------------------------------------------
# DEBUG MASKs
# set debug mask according to the definitions below
# debug information is written via standard log mechanism
#   STATUS    0x00000001  - output STATUS (marked with 'S-')
#   ERROR     0x00000002  - output ERRORs (marked with 'E-')
#   WARN      0x00000004  - output WARNINGs (marked with 'W-')
#   INFO      0x00000008  - output info (marked with 'I-')
#   WRAPPER   0x00000010  - output details of the stack encapsulation (marked with 'A-')
#   DETAIL    0x00000020  - output detail (creates a lot of output) (marked with 'V-')
#   DATA      0x00000040  - output data (for data messages) (marked with 'D-')
#   PERROR    0x00000080  - output pointer errors (marked with 'R-')
#   NCCI_STM  0x00000100  - output Capi NCCI statemachine (marked with 'N-')
#   PLCI_STM  0x00000200  - output Capi PLCI statemachine (marked with 'P-')
#   CONT_STM  0x00000400  - output Capi Controller statemachine (marked with 'C-')
#   MALLOC    0x00000800  - output memory allocation errors 
#                           (creates a lot of output, do not use if not requested)
#                           (marked with 'M-')
#   TIMER     0x00001000  - output timer handling 
#                           (creates a lot of output, do not use if not requested) 
#                           (marked with 'T-')
# in general a debug mask set to 0x00000007 should be sufficient
#----------------------------------------------------------------------------------
ISUP_CC_DEBUG_MASK   0x00000007  # set to STATUS|ERROR|WARN
MTP3_MTP2_DEBUG_MASK 0x00000007  # set to STATUS|ERROR|WARN
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
# Controller configuration
#   This paragraphs were changed from 1.2 to 1.5
#   The 'old' style configuration will still work
#   Using the 'old' style will cause the following Warning on startup:
#   W-CONFIGURATION: cc_prov: no Controller Configuration found - assuming old format
#   W-                        This may cause fatal errors if your DIVA server adapter
#   W-                        numbering changes
#   W-                        (e.g. adapter was not found while rebooting)
#
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# Reason for the change:
#   The 'old' configuration may cause fatal errors.
#   In the 'old' configuration the CAPI adapter number was used to
#   identify the DIVA server controller/trunk.
#   The mapping between the CAPI adapter number and the physical
#   DIVA server controller/trunk is not hard wired.
#   When adding an additional, removing or crash of a DIVA server 
#   controller/trunk the mapping between CAPI adapter number 
#   DIVA server controllers/trunks may change.
#   Even on startup the DIVA server controllers/trunks may be detected
#   in a different sequence and therefore the mapping may change.
#   The only secure way to identify a DIVA server controller/trunk is
#   via serial number.
#
#             There are different formats for the serial numbers:
#             1234      - single controller 
#                         or first controller of a multispan DIVA server card 
#                         running on LINUX
#
#             1234-1    - serial numbers of controllers on a multispan card      
#             1234-2      LINUX would not display 1234-1 but 1234
#             1234-3      -> the serial numbers in the configuration of Linux 
#             1234-4         would be 1234, 1234-2, 1234-3, 1234-4
#              
#             Windows adds an additional number identifying the DIVA server
#             card type: 1234-72    -> PRI v3.0 E1/T1 8M
#                        1234-1-85  -> first controller on Diva Server 4PRI/E1/T1  
#             The cardtype is ignored -> please do not add the type to the 
#             configuration of the serial  
#
# How to obtain the serial number of your adapters:
#   Windows: - open the Diva Server Configuration Manager
#            - click onto the corresponding adapter symbol
#            - in the properties You will find the serial number
#            - for multispan adapters you have to append the 'Lines'
#              after the serial '-1', '-2', ...
#   Linux:  run the tool adapter_info.sh and the serial numbers of the 
#           DIVA Server controllers will be displayed
#
# Note: to enable the handling of the serials (windows/linux), serial
#       numbers without the 'port'-number (sub adapter number) will have appended 
#       automatically the '-1'                        
#----------------------------------------------------------------------------------
NUM_CONTROLLER 1
#----------------------------------------------------------------------------------
#LogControllerNum local  law    SerialN
CONTROLLER_CONFIG_START
1                 local  A      1300
CONTROLLER_CONFIG_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#CC_PROVISIONING
#----------------------------------------------------------------------------------
# number of terminals configured/used
CC_NUM_TERMINALS   30
#----------------------------------------------------------------------------------
# length called party number
CC_LENGTH_CALLED_PARTY_NUMBER_START
0
CC_LENGTH_CALLED_PARTY_NUMBER_END
#----------------------------------------------------------------------------------
# initial state 0-PAUSE 1-ACTIVE
CC_INITIAL_STATE 0
#----------------------------------------------------------------------------------
# Due to the increased functionality of the blocking, the configuration of 
# the blocking is enhanced
#
# LSB - bit 0 0x01   local maintenance blocking (by operator) (Note1)  
#       bit 1 0x02   local hardware blocking (by operator)    (Note2)
#       bit 2        reserved
#       bit 3        reserved
#       bit 4 0x10   follow remote blocking                   (Note3)
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#       bit 5        reserved
#       bit 6 0x40   inbound calls disabled                   (Note4)
# MSB   bit 7 0x80   outbound calls disabled                  (Note4)
#
# All theses values may be superseded by management when 
# ISUP/CallControl is started
# Note1: local maintenance blocking may be set/reset additionally via
#        DIVA server adapter management and when follow remote is set
# Note2: local hardware blocking is as well set/reset when Layer 1 of 
#        DIVA server adapter is Down OR the CAPI connection to the 
#        DIVA server adapter is lost (no path to the applications)
# Note3: When follow remote is set, local maintenance blocking will be 
#        set/reset when blocking/unblocking is received from the 
#        remote peer
# Note4: The disabling of in-/outbound calls can NOT be signaled to
#        the remote peer. 
#        Therefore be sure, that the administrator of the peer is 
#        aware if the disabling is set.
#        Even if those values can be set/reset when started, but 
#        it does not make sense to do it, other than for testing purpose.
#
# These bits may be combined
# Examples: 0x11  - local maintenance blocking is set,
#                   follow remote is set
#           0xC0  - inbound and outbound calls are disabled
#
# You may set those values as well decimal:
# Examples: 0x11 corresponds to 17
#           0xC0 corresponds to 192
#----------------------------------------------------------------------------------
#CIC OPC DPC LogContrNum Timeslot  Blocked
CC_TERMINAL_CONFIG_START
  1   129 130       1        1      0
  2   129 130       1        2      0
  3   129 130       1        3      0 
  4   129 130       1        4      0
  5   129 130       1        5      0
  6   129 130       1        6      0
  7   129 130       1        7      0
  8   129 130       1        8      0
  9   129 130       1        9      0
 10   129 130       1       10      0
 11   129 130       1       11      0
 12   129 130       1       12      0
 13   129 130       1       13      0
 14   129 130       1       14      0
 15   129 130       1       15      0
 17   129 130       1       17      0
 18   129 130       1       18      0
 19   129 130       1       19      0
 20   129 130       1       20      0
 21   129 130       1       21      0
 22   129 130       1       22      0
 23   129 130       1       23      0
 24   129 130       1       24      0
 25   129 130       1       25      0
 26   129 130       1       26      0
 27   129 130       1       27      0
 28   129 130       1       28      0
 29   129 130       1       29      0
 30   129 130       1       30      0
 31   129 130       1       31      0
CC_TERMINAL_CONFIG_END 
#----------------------------------------------------------------------------------
#CC_PROVISIONING_END
#----------------------------------------------------------------------------------
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#----------------------------------------------------------------------------------
#ISUP_PROVISIONING
#----------------------------------------------------------------------------------
ISUP_CIC_CONFIG_START
#    Status:  Delete  = 0, Add = 1
ISUP_CIC_CONFIG
     OPC       DPC     START_CIC     NUM_OF_CICS 
     129       130       1            15
     129       130       17           15
ISUP_CIC_CONFIG_END
#----------------------------------------------------------------------------------
# Network Protection timer (ITU-T Q.764 T7)
# Started after the transmission of an IAM. Stopped when ACM is received. 
# On expiry the connection is released.
# ITU-T Q.764 - Standard: 20-30 sec
# Implementation default: 20 sec
# If You require a different value, uncomment line and change value according
# ISUP_T7 20
#----------------------------------------------------------------------------------
#ISUP_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP3_PROVISIONING
#----------------------------------------------------------------------------------
MTP3_SELF_POINT_CODE_START
# PC: Self Point Code 
# Type:  Primary PC = 81, SECONDARY = 82 CAPABILITY CODE =83
# Point code of MTP3
#  PC  Nodecap Status 
MTP3_SELF_POINT_CODE
#OPC SPC_TYPE
129  81   
MTP3_SELF_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE_START
#  Destination Type Bitwise Usage:
# Bit   Value  Definition
#  Most Significant Bit   0Destination is DPC
# Ist Bit   1(0x01) Adj DPC
# 2nd Bit   1(0x02) Rem DPC
# 3rd Bit  0/1(0/0x04) Brdcast_opt enable/disable
# 4th Bit  0/1(0/0x08) dpc is mated_stp/non mated
#  Status:  Delete  = 0, Add = 1
#  DPC Type  Sls  Status
#---------------------------
MTP3_DEST_POINT_CODE
DPC Type sls
130 1  1
MTP3_DEST_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_LINK_START
#  LINK_TYPE : Link Type A ...F , Value 1,2 ...6
MTP3_LINK
OPC  DPC  SLC  MTP2_ID  LOG_DATA_LINK_ID  LINK_TYPE  ROUTE_PARAM_LOG_LINK_ID 
129  130   0     0          1                1            1 
MTP3_LINK_END
#----------------------------------------------------------------------------------
MTP3_LINK_SET_START
#Put the information in following order
# (1)OPC (2)DPC (3)Num_Links (4)Num_Normal_Links 
# (5)Broadcast_Option  (6)Linkset_Option 
# (7){Log_Link_Id, Link_State, Link_Priority} for each link
# (8) Log_Link_Set_Id
#   Priority : 1 to XX
#   LinkState : Active = 0, Inactive = 1
#   Status:  Delete  = 0, Add = 1
#   BRDCAST_OPT:  enable: 0, disable: 1
MTP3_LINK_SET
opc dpc nlks nrml_lks bd_opt lset_opt lset_id lk_id lk_state lk_prio
129 130   1     1       0        0       1  1       0       0        
MTP3_LINK_SET_END
#----------------------------------------------------------------------------------



Appendix

Dialogic® Diva® softSS7 for Windows Reference Guide page 26 

MTP3_ROUTE_START
#  ROUTE_TYPE Bitwise Usage:
# Bit       Value Definition
#  Most Significant Bit  0/1 Destination is Route/CLUSTER Route
# Ist Bit   1/2 Direct/Indirect Route
#  DPC is a cluster if the route is a cluster route

MTP3_ROUTE
OPC  DPC  ROUTE_TYPE  LOG_LINKSET_ID   PRIORITY ROUTE_PARAM_LOG_ROUTE_ID
129  130    1              1               1             1
MTP3_ROUTE_END
#----------------------------------------------------------------------------------
# Overall MTP restart timer (ITU-T Q.704 T20)
# Started when first link of linkset is available. 
# Time required to do the routing update.
# On expiry TRA message (traffic restart allowed) will be transmitted
# ITU-T Q.704 - Standard: 59-61 sec
# Implementation default: 59 sec
# If You require a different value, uncomment line and change value according
# MTP3_T20 59
#----------------------------------------------------------------------------------
#MTP3_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP2_PROVISIONING
#----------------------------------------------------------------------------------
#  number of MTP2 signaling links
MTP2_NUM_LINKS 1
#----------------------------------------------------------------------------------
# Configuration of MTP2 links:
#
# MTP2_LOG_LINK_ID - MTP2 Link Id
# MTP2_ID          - MTP2 Id
# MTP2_CONTROLLER  - identifies the controller on which the link is set up
#                    (log-controller number)
# MTP2_TIMESLOT    - defines the timeslot of the link
# MTP2_MODE        - defines the MTP2 mode 
#                    0 - normal mode
#                    1 - preventive mode
#----------------------------------------------------------------------------------
#MTP2_LOG_LINK_ID    MTP2_ID    MTP2_CONTROLLER   MTP2_TIMESLOT   MTP2_MODE
MTP2_LINK_CONFIG_START
  1                   0          1                 16              0
MTP2_LINK_CONFIG_END
#----------------------------------------------------------------------------------
#MTP2_PROVISIONING_END
#----------------------------------------------------------------------------------

Back to Back test

For the back-to-back test you need two systems. Below you will find two divaSS7.cfg configuration files for a 

back-to-back test. It has 1 SS7 link and 30 CICs.



Appendix

Dialogic® Diva® softSS7 for Windows Reference Guide page 27 

First divaSS7.cfg file

#----------------------------------------------------------------------------------
# STACK_STANDARD_TYPE : Specifies the variant of the stack 
# ITU= 1, ETSI=2
#----------------------------------------------------------------------------------
STACK_STANDARD_TYPE              1 
#----------------------------------------------------------------------------------
# NETWORK_INDICATOR : Specifies the network indicator of ISUP and MTP3 
# International 0 = 0, International 1 / SPARE = 1, 
# National 0 = 2, National 1 (Reserved for national use) = 3
#----------------------------------------------------------------------------------
NETWORK_INDICATOR                2 
#----------------------------------------------------------------------------------
# MTP3 and ISUP are communicating via (local) sockets with each other 
# -> therefore the below paragraph is required 
# MTP3_IP_ADDRESS          - IP of MTP3 
# ISUP_IP_ADDRESS          - IP of ISUP 
# MTP3_SERVER_PORT         - MTP3 server port to which the ISUP client is connecting
# ISUP_SERVER_PORT         - ISUP server port to which the MTP3 client is connecting
# MTP3_CLIENT_TO_ISUP_PORT - MTP3 client port which connects to the ISUP server
# ISUP_CLIENT_TO_MTP3_PORT - ISUP client port which connects to the MTP3 server
# all entries are required
#----------------------------------------------------------------------------------
MTP3_IP_ADDRESS                 127.0.0.1
MTP3_SERVER_PORT                13000
MTP3_CLIENT_TO_ISUP_PORT        13100
ISUP_IP_ADDRESS                 127.0.0.1
ISUP_SERVER_PORT                14000
ISUP_CLIENT_TO_MTP3_PORT        14100
#----------------------------------------------------------------------------------
# DEBUG MASKs
# set debug mask according to the definitions below
# debug information is written via standard log mechanism
#   STATUS    0x00000001  - output STATUS (marked with 'S-')
#   ERROR     0x00000002  - output ERRORs (marked with 'E-')
#   WARN      0x00000004  - output WARNINGs (marked with 'W-')
#   INFO      0x00000008  - output info (marked with 'I-')
#   WRAPPER   0x00000010  - output details of the stack encapsulation (marked with 'A-')
#   DETAIL    0x00000020  - output detail (creates a lot of output) (marked with 'V-')
#   DATA      0x00000040  - output data (for data messages) (marked with 'D-')
#   PERROR    0x00000080  - output pointer errors (marked with 'R-')
#   NCCI_STM  0x00000100  - output Capi NCCI statemachine (marked with 'N-')
#   PLCI_STM  0x00000200  - output Capi PLCI statemachine (marked with 'P-')
#   CONT_STM  0x00000400  - output Capi Controller statemachine (marked with 'C-')
#   MALLOC    0x00000800  - output memory allocation errors 
#                           (creates a lot of output, do not use if not requested) 
#                           (marked with 'M-')
#   TIMER     0x00001000  - output timer handling 
#                           (creates a lot of output, do not use if not requested) 
#                           (marked with 'T-')
# in general a debug mask set to 0x00000007 should be sufficient
#----------------------------------------------------------------------------------
ISUP_CC_DEBUG_MASK   0x00000007  # set to STATUS|ERROR|WARN
MTP3_MTP2_DEBUG_MASK 0x00000007  # set to STATUS|ERROR|WARN 
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
# Controller configuration
#----------------------------------------------------------------------------------
NUM_CONTROLLER 1
#LogControllerNum local  law    SerialN
#----------------------------------------------------------------------------------
CONTROLLER_CONFIG_START
1                 local  A      1300
CONTROLLER_CONFIG_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#CC_PROVISIONING
#----------------------------------------------------------------------------------
# number of terminals configured/used
CC_NUM_TERMINALS   30
#----------------------------------------------------------------------------------
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# length called party number
CC_LENGTH_CALLED_PARTY_NUMBER_START
0
CC_LENGTH_CALLED_PARTY_NUMBER_END
#----------------------------------------------------------------------------------
# initial state 0-PAUSE 1-ACTIVE
CC_INITIAL_STATE 0
#----------------------------------------------------------------------------------
#CIC OPC DPC LogContrNum Timeslot  Blocked
CC_TERMINAL_CONFIG_START
  1   129 130       1        1      0
  2   129 130       1        2      0
  3   129 130       1        3      0 
  4   129 130       1        4      0
  5   129 130       1        5      0
  6   129 130       1        6      0
  7   129 130       1        7      0
  8   129 130       1        8      0
  9   129 130       1        9      0
 10   129 130       1       10      0
 11   129 130       1       11      0
 12   129 130       1       12      0
 13   129 130       1       13      0
 14   129 130       1       14      0
 15   129 130       1       15      0
 17   129 130       1       17      0
 18   129 130       1       18      0
 19   129 130       1       19      0
 20   129 130       1       20      0
 21   129 130       1       21      0
 22   129 130       1       22      0
 23   129 130       1       23      0
 24   129 130       1       24      0
 25   129 130       1       25      0
 26   129 130       1       26      0
 27   129 130       1       27      0
 28   129 130       1       28      0
 29   129 130       1       29      0
 30   129 130       1       30      0
 31   129 130       1       31      0
CC_TERMINAL_CONFIG_END 
#----------------------------------------------------------------------------------
#CC_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#ISUP_PROVISIONING
#----------------------------------------------------------------------------------
ISUP_CIC_CONFIG_START
#    Status:  Delete  = 0, Add = 1
ISUP_CIC_CONFIG
     OPC       DPC     START_CIC     NUM_OF_CICS 
     129       130       1            15
     129       130       17           15
ISUP_CIC_CONFIG_END
#----------------------------------------------------------------------------------
#ISUP_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP3_PROVISIONING
#----------------------------------------------------------------------------------
MTP3_SELF_POINT_CODE_START
# PC: Self Point Code 
# Type:  Primary PC = 81, SECONDARY = 82 CAPABILITY CODE =83
# Point code of MTP3
#  PC  Nodecap Status 
MTP3_SELF_POINT_CODE
#OPC SPC_TYPE
129  81   
MTP3_SELF_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE_START
#  Destination Type Bitwise Usage:
# Bit  Value Definition
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#  Most Significant Bit   0 Destination is DPC
# Ist Bit   1(0x01) Adj DPC
# 2nd Bit  1(0x02) Rem DPC
# 3rd Bit  0/1(0/0x04) Brdcast_opt enable/disable
# 4th Bit  0/1(0/0x08) dpc is mated_stp/non mated
#  Status:  Delete  = 0, Add = 1
#  DPC Type  Sls Status
#---------------------------
MTP3_DEST_POINT_CODE
DPC Type sls
130  1  1
MTP3_DEST_POINT_CODE_END
#----------------------------------------------------------------------------------

MTP3_LINK_START
#  LINK_TYPE : Link Type A ...F , Value 1,2 ...6
MTP3_LINK
OPC  DPC  SLC  MTP2_ID  LOG_DATA_LINK_ID  LINK_TYPE  ROUTE_PARAM_LOG_LINK_ID 
129  130   0     0          1                1            1 
MTP3_LINK_END
#----------------------------------------------------------------------------------
MTP3_LINK_SET_START
#Put the information in following order
# (1)OPC (2)DPC (3)Num_Links (4)Num_Normal_Links 
# (5)Broadcast_Option  (6)Linkset_Option 
# (7){Log_Link_Id, Link_State, Link_Priority} for each link
# (8) Log_Link_Set_Id
#   Priority : 1 to XX
#   LinkState : Active = 0, Inactive = 1
#   Status:  Delete  = 0, Add = 1
#   BRDCAST_OPT:  enable: 0, disable: 1
MTP3_LINK_SET
opc dpc nlks nrml_lks bd_opt lset_opt lset_id lk_id lk_state lk_prio
129 130   1     1       0        0       1  1       0       0        
MTP3_LINK_SET_END
#----------------------------------------------------------------------------------
MTP3_ROUTE_START
#  ROUTE_TYPE Bitwise Usage:
# Bit  Value  Definition
#  Most Significant Bit  0/1 Destination is Route/CLUSTER Route
# Ist Bit  1/2 Direct/Indirect Route
#  DPC is a cluster if the route is a cluster route
MTP3_ROUTE
OPC  DPC  ROUTE_TYPE  LOG_LINKSET_ID   PRIORITY ROUTE_PARAM_LOG_ROUTE_ID
129  130    1              1               1             1
MTP3_ROUTE_END
#----------------------------------------------------------------------------------
#MTP3_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP2_PROVISIONING
#----------------------------------------------------------------------------------
#  number of MTP2 signaling links
MTP2_NUM_LINKS 1
#----------------------------------------------------------------------------------
# Configuration of MTP2 links:
#
# MTP2_LOG_LINK_ID - MTP2 Link Id
# MTP2_ID          - MTP2 Id
# MTP2_CONTROLLER  - identifies the controller on which the link is set up
#                    (log-controller number)
# MTP2_TIMESLOT    - defines the timeslot of the link
# MTP2_MODE        - defines the MTP2 mode 
#                    0 - normal mode
#                    1 - preventive mode
#----------------------------------------------------------------------------------
#MTP2_LOG_LINK_ID    MTP2_ID    MTP2_CONTROLLER   MTP2_TIMESLOT   MTP2_MODE
MTP2_LINK_CONFIG_START
  1                   0          1                 16              0
MTP2_LINK_CONFIG_END
#----------------------------------------------------------------------------------
#MTP2_PROVISIONING_END
#----------------------------------------------------------------------------------
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Second divaSS7.cfg file

#----------------------------------------------------------------------------------
# STACK_STANDARD_TYPE : Specifies the variant of the stack 
# ITU= 1, ETSI=2
#----------------------------------------------------------------------------------
STACK_STANDARD_TYPE              1 
#----------------------------------------------------------------------------------
# NETWORK_INDICATOR : Specifies the network indicator of ISUP and MTP3 
# International 0 = 0, International 1 / SPARE = 1, 
# National 0 = 2, National 1 (Reserved for national use) = 3
#----------------------------------------------------------------------------------
NETWORK_INDICATOR                2 
#----------------------------------------------------------------------------------
# MTP3 and ISUP are communicating via (local) sockets with each other 
# -> therefore the below paragraph is required 
# MTP3_IP_ADDRESS          - IP of MTP3 
# ISUP_IP_ADDRESS          - IP of ISUP 
# MTP3_SERVER_PORT         - MTP3 server port to which the ISUP client is connecting
# ISUP_SERVER_PORT         - ISUP server port to which the MTP3 client is connecting
# MTP3_CLIENT_TO_ISUP_PORT - MTP3 client port which connects to the ISUP server
# ISUP_CLIENT_TO_MTP3_PORT - ISUP client port which connects to the MTP3 server
# all entries are required
#----------------------------------------------------------------------------------
MTP3_IP_ADDRESS                 127.0.0.1
MTP3_SERVER_PORT                13000
MTP3_CLIENT_TO_ISUP_PORT        13100
ISUP_IP_ADDRESS                 127.0.0.1
ISUP_SERVER_PORT                14000
ISUP_CLIENT_TO_MTP3_PORT        14100
#----------------------------------------------------------------------------------
# DEBUG MASKs
# set debug mask according to the definitions below
# debug information is written via standard log mechanism
#   STATUS    0x00000001  - output STATUS (marked with 'S-')
#   ERROR     0x00000002  - output ERRORs (marked with 'E-')
#   WARN      0x00000004  - output WARNINGs (marked with 'W-')
#   INFO      0x00000008  - output info (marked with 'I-')
#   WRAPPER   0x00000010  - output details of the stack encapsulation (marked with 'A-')
#   DETAIL    0x00000020  - output detail (creates a lot of output) (marked with 'V-')
#   DATA      0x00000040  - output data (for data messages) (marked with 'D-')
#   PERROR    0x00000080  - output pointer errors (marked with 'R-')
#   NCCI_STM  0x00000100  - output Capi NCCI statemachine (marked with 'N-')
#   PLCI_STM  0x00000200  - output Capi PLCI statemachine (marked with 'P-')
#   CONT_STM  0x00000400  - output Capi Controller statemachine (marked with 'C-')
#   MALLOC    0x00000800  - output memory allocation errors 
#                           (creates a lot of output, do not use if not requested)
#                           (marked with 'M-')
#   TIMER     0x00001000  - output timer handling 
#                           (creates a lot of output, do not use if not requested)
#                           (marked with 'T-')
# in general a debug mask set to 0x00000007 should be sufficient
#----------------------------------------------------------------------------------
ISUP_CC_DEBUG_MASK   0x000003FF  # set to STATUS|ERROR|WARN|INFO
MTP3_MTP2_DEBUG_MASK 0x000003FF  # set to STATUS|ERROR|WARN 
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
# Controller configuration
#----------------------------------------------------------------------------------
NUM_CONTROLLER 1
#----------------------------------------------------------------------------------
#LogControllerNum local  law    SerialN
CONTROLLER_CONFIG_START
1                 local  A      1455
CONTROLLER_CONFIG_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#CC_PROVISIONING
#----------------------------------------------------------------------------------
# number of terminals configured/used
CC_NUM_TERMINALS   30
#----------------------------------------------------------------------------------
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# length called party number
CC_LENGTH_CALLED_PARTY_NUMBER_START
0
CC_LENGTH_CALLED_PARTY_NUMBER_END
#----------------------------------------------------------------------------------
# initial state 0-PAUSE 1-ACTIVE
CC_INITIAL_STATE 0
#----------------------------------------------------------------------------------
# Note: the order of the CIC definition is changed to avoid collisions
#CIC OPC DPC LogContrNum Timeslot  Blocked
CC_TERMINAL_CONFIG_START
31   130 129 1 31 0
30   130 129 1 30 0
29   130 129 1 29 0
28   130 129 1 28 0
27   130 129 1 27 0
26   130 129 1 26 0
25   130 129 1 25 0
24   130 129 1 24 0
23   130 129 1 23 0
22   130 129 1 22 0
21   130 129 1 21 0
20   130 129 1 20 0
19   130 129 1 19 0
18   130 129 1 18 0
17   130 129 1 17 0
15   130 129 1 15 0
14   130 129 1 14 0
13   130 129 1 13 0
12   130 129 1 12 0
11   130 129 1 11 0
10   130 129 1 10 0
9    130 129 1 9 0
8    130 129 1 8 0
7    130 129 1 7 0
6    130 129 1 6 0
5    130 129 1 5 0
4    130 129 1 4 0
3    130 129 1 3 0
2    130 129 1 2 0
1    130 129 1 1 0
CC_TERMINAL_CONFIG_END 
#----------------------------------------------------------------------------------
#CC_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#ISUP_PROVISIONING
#----------------------------------------------------------------------------------
ISUP_CIC_CONFIG_START
#    Status:  Delete  = 0, Add = 1
ISUP_CIC_CONFIG
     OPC       DPC     START_CIC     NUM_OF_CICS 
     130       129       1             15
     130       129       17            15
ISUP_CIC_CONFIG_END
#----------------------------------------------------------------------------------
#ISUP_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP3_PROVISIONING
#----------------------------------------------------------------------------------
MTP3_SELF_POINT_CODE_START
# PC: Self Point Code 
# Type:  Primary PC = 81, SECONDARY = 82 CAPABILITY CODE =83
# Point code of MTP3
#  PC  Nodecap Status 
MTP3_SELF_POINT_CODE
PC SPC_TYPE
130  81   
MTP3_SELF_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE_START
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#  Destination Type Bitwise Usage:
# Bit   Value  Definition
#  Most Significant Bit   0 Destination is DPC
# Ist Bit 1(0x01) Adj DPC
# 2nd Bit 1(0x02) Rem DPC
# 3rd Bit 0/1(0/0x04)Brdcast_opt enable/disable
# 4th Bit  0/1(0/0x08)dpc is mated_stp/non mated

#  Status:  Delete  = 0, Add = 1
#  DPC Type  Sls  Status
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE
DPC Type sls
129  1  1
MTP3_DEST_POINT_CODE_END
#----------------------------------------------------------------------------------

MTP3_LINK_START
#  LINK_TYPE : Link Type A ...F , Value 1,2 ...6
MTP3_LINK
OPC  DPC  SLC  MTP2_ID  LOG_DATA_LINK_ID  LINK_TYPE  ROUTE_PARAM_LOG_LINK_ID 
130  129   0     0          1                1            1 
MTP3_LINK_END
#----------------------------------------------------------------------------------
MTP3_LINK_SET_START
#Put the information in following order
# (1)OPC (2)DPC (3)Num_Links (4)Num_Normal_Links 
# (5)Broadcast_Option  (6)Linkset_Option 
# (7){Log_Link_Id, Link_State, Link_Priority} for each link
# (8) Log_Link_Set_Id
#   Priority : 1 to XX
#   LinkState : Active = 0, Inactive = 1
#   Status:  Delete  = 0, Add = 1
#   BRDCAST_OPT:  enable: 0, disable: 1
MTP3_LINK_SET
opc dpc nlks nrml_lks bd_opt lset_opt lset_id lk_id lk_state lk_prio
130 129   1     1       0        0       1  1       0       0        
MTP3_LINK_SET_END
#----------------------------------------------------------------------------------
MTP3_ROUTE_START
#  ROUTE_TYPE Bitwise Usage:
# Bit Value   Definition
#  Most Significant Bit  0/1 Destination is Route/CLUSTER Route
# Ist Bit  1/2 Direct/Indirect Route
#  DPC is a cluster if the route is a cluster route
MTP3_ROUTE
OPC  DPC  ROUTE_TYPE  LOG_LINKSET_ID   PRIORITY ROUTE_PARAM_LOG_ROUTE_ID
130  129    1              1               1             1
MTP3_ROUTE_END
#----------------------------------------------------------------------------------
#MTP3_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP2_PROVISIONING
#----------------------------------------------------------------------------------
#  number of MTP2 signaling links
MTP2_NUM_LINKS 1
#----------------------------------------------------------------------------------
# Configuration of MTP2 links:
#
# MTP2_LOG_LINK_ID - MTP2 Link Id
# MTP2_ID          - MTP2 Id
# MTP2_CONTROLLER  - identifies the controller on which the link is set up
#                    (log-controller number)
# MTP2_TIMESLOT    - defines the timeslot of the link
# MTP2_MODE        - defines the MTP2 mode 
#                    0 - normal mode
#                    1 - preventive mode
#----------------------------------------------------------------------------------
#MTP2_LOG_LINK_ID    MTP2_ID    MTP2_CONTROLLER   MTP2_TIMESLOT   MTP2_MODE
MTP2_LINK_CONFIG_START
  1                   0          1                 16              0
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MTP2_LINK_CONFIG_END
#----------------------------------------------------------------------------------
#MTP2_PROVISIONING_END
#----------------------------------------------------------------------------------

Example: One SS7 link on one controller and 31 CICs on another controller

In this example, there are two 2MB trunks connected to the SS7 network. On the first trunk, one SS7 link is 

configured (controller 1) towards DPC=4119 and on the second trunk 31 CICs are configured (controller 2) 

towards DPC=3031:

#----------------------------------------------------------------------------------
# STACK_STANDARD_TYPE : Specifies the variant of the stack 
# ITU= 1, ETSI=2
#----------------------------------------------------------------------------------
STACK_STANDARD_TYPE              1 
#----------------------------------------------------------------------------------
# NETWORK_INDICATOR : Specifies the network indicator of ISUP and MTP3 
# International 0 = 0, International 1 / SPARE = 1, 
# National 0 = 2, National 1 (Reserved for national use) = 3
#----------------------------------------------------------------------------------
NETWORK_INDICATOR                2 
#----------------------------------------------------------------------------------
# MTP3 and ISUP are communicating via (local) sockets with each other 
# -> therefore the below paragraph is required 
# MTP3_IP_ADDRESS          - IP of MTP3 
# ISUP_IP_ADDRESS          - IP of ISUP 
# MTP3_SERVER_PORT         - MTP3 server port to which the ISUP client is connecting
# ISUP_SERVER_PORT         - ISUP server port to which the MTP3 client is connecting
# MTP3_CLIENT_TO_ISUP_PORT - MTP3 client port which connects to the ISUP server
# ISUP_CLIENT_TO_MTP3_PORT - ISUP client port which connects to the MTP3 server
# all entries are required
#----------------------------------------------------------------------------------
MTP3_IP_ADDRESS                 127.0.0.1
MTP3_SERVER_PORT                13000
MTP3_CLIENT_TO_ISUP_PORT        13100
ISUP_IP_ADDRESS                 127.0.0.1
ISUP_SERVER_PORT                14000
ISUP_CLIENT_TO_MTP3_PORT        14100
#----------------------------------------------------------------------------------
# DEBUG MASKs
# set debug mask according to the definitions below
# debug information is written via standard log mechanism
#   STATUS    0x00000001  - output STATUS (marked with 'S-')
#   ERROR     0x00000002  - output ERRORs (marked with 'E-')
#   WARN      0x00000004  - output WARNINGs (marked with 'W-')
#   INFO      0x00000008  - output info (marked with 'I-')
#   WRAPPER   0x00000010  - output details of the stack encapsulation (marked with 'A-')
#   DETAIL    0x00000020  - output detail (creates a lot of output) (marked with 'V-')
#   DATA      0x00000040  - output data (for data messages) (marked with 'D-')
#   PERROR    0x00000080  - output pointer errors (marked with 'R-')
#   NCCI_STM  0x00000100  - output Capi NCCI statemachine (marked with 'N-')
#   PLCI_STM  0x00000200  - output Capi PLCI statemachine (marked with 'P-')
#   CONT_STM  0x00000400  - output Capi Controller statemachine (marked with 'C-')
#   MALLOC    0x00000800  - output memory allocation errors 
#                           (creates a lot of output, do not use if not requested) 
#                           (marked with 'M-')
#   TIMER     0x00001000  - output timer handling 
#                           (creates a lot of output, do not use if not requested) 
#                           (marked with 'T-')
# in general a debug mask set to 0x00000007 should be sufficient
#----------------------------------------------------------------------------------
ISUP_CC_DEBUG_MASK   0x000003FF  # set to STATUS|ERROR|WARN|INFO
MTP3_MTP2_DEBUG_MASK 0x000003FF  # set to STATUS|ERROR|WARN 
#----------------------------------------------------------------------------------
# Controller configuration
#----------------------------------------------------------------------------------
NUM_CONTROLLER 2
#----------------------------------------------------------------------------------
#LogControllerNum local  law SerialN
CONTROLLER_CONFIG_START
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1              local      A   1001    
2              local      A   1084
CONTROLLER_CONFIG_END

#----------------------------------------------------------------------------------
#CC_PROVISIONING
#----------------------------------------------------------------------------------
CC_NUM_VIRTUAL_SIG_CONTROLLER 2
#LogControllerNum local  law
CC_CONTROLLER_CONFIG_START
1              local  A
2              local  A
CC_CONTROLLER_CONFIG_END
#----------------------------------------------------------------------------------
CC_NUM_TERMINALS   31
#----------------------------------------------------------------------------------
CC_LENGTH_CALLED_PARTY_NUMBER_START
0
CC_LENGTH_CALLED_PARTY_NUMBER_END
#----------------------------------------------------------------------------------
# initial state 0-PAUSE 1-ACTIVE
CC_INITIAL_STATE 0
#----------------------------------------------------------------------------------
#CIC OPC DPC LogContrNum Timeslot  Blocked
CC_TERMINAL_CONFIG_START
 1   7072 3031       2          1      0
 2   7072 3031       2          2      0
 3   7072 3031       2          3      0 
 4   7072 3031       2          4      0
 5   7072 3031       2          5      0
 6   7072 3031       2          6      0
 7   7072 3031       2          7      0
 8   7072 3031       2          8      0
 9   7072 3031       2          9      0
 10  7072 3031       2         10      0
 11  7072 3031       2         11      0
 12  7072 3031       2         12      0
 13  7072 3031       2         13      0
 14  7072 3031       2         14      0
 15  7072 3031       2         15      0
 16  7072 3031       2         16      0
 17  7072 3031       2         17      0
 18  7072 3031       2         18      0
 19  7072 3031       2         19      0
 20  7072 3031       2         20      0
 21  7072 3031       2         21      0
 22  7072 3031       2         22      0
 23  7072 3031       2         23      0
 24  7072 3031       2         24      0
 25  7072 3031       2         25      0
 26  7072 3031       2         26      0
 27  7072 3031       2         27      0
 28  7072 3031       2         28      0
 29  7072 3031       2         29      0
 30  7072 3031       2         30      0
 31  7072 3031       2         31      0
CC_TERMINAL_CONFIG_END 
#----------------------------------------------------------------------------------
#CC_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#ISUP_PROVISIONING
#----------------------------------------------------------------------------------
ISUP_CIC_CONFIG_START
#    Status:  Delete  = 0, Add = 1
ISUP_CIC_CONFIG
OPC       DPC     START_CIC     NUM_OF_CICS 
7072      3031       1              31
ISUP_CIC_CONFIG_END
#----------------------------------------------------------------------------------
#ISUP_PROVISIONING_END
#----------------------------------------------------------------------------------
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#----------------------------------------------------------------------------------
#MTP3_PROVISIONING
#----------------------------------------------------------------------------------
MTP3_SELF_POINT_CODE_START
# PC: Self Point Code 
# Type:  Primary PC = 81, SECONDARY = 82 CAPABILITY CODE =83
# Point code of MTP3
#  PC  Nodecap Status 
MTP3_SELF_POINT_CODE
PC SPC_TYPE
7072 81   
MTP3_SELF_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE_START
#  Destination Type Bitwise Usage:
# Bit   Value  Definition
#  Most Significant Bit  0 Destination is DPC
# Ist Bit  1(0x01) Adj DPC
# 2nd Bit 1(0x02) Rem DPC
# 3rd Bit 0/1(0/0x04)Brdcast_opt enable/disable
# 4th Bit 0/1(0/0x08)dpc is mated_stp/non mated
#  Status:  Delete  = 0, Add = 1
#  DPC Type  Sls  Status
#----------------------------------------------------------------------------------
MTP3_DEST_POINT_CODE
DPC Type sls
4119 1 1
3031 2 1
MTP3_DEST_POINT_CODE_END
#----------------------------------------------------------------------------------
MTP3_LINK_START
#  LINK_TYPE : Link Type A ...F , Value 1,2 ...6
MTP3_LINK
OPC    DPC  SLC  MTP2_ID  LOG_DATA_LINK_ID  LINK_TYPE  ROUTE_PARAM_LOG_LINK_ID 
7072  4119   0     0          1            1            1 
MTP3_LINK_END
#----------------------------------------------------------------------------------
MTP3_LINK_SET_START
#Put the information in following order
# (1)OPC (2)DPC (3)Num_Links (4)Num_Normal_Links 
# (5)Broadcast_Option  (6)Linkset_Option 
# (7){Log_Link_Id, Link_State, Link_Priority} for each link
# (8) Log_Link_Set_Id
#   Priority : 1 to XX
#   LinkState : Active = 0, Inactive = 1
#   Status:  Delete  = 0, Add = 1
#   BRDCAST_OPT:  enable: 0, disable: 1
MTP3_LINK_SET
opc dpc nlks nrml_lks bd_opt lset_opt lset_id lk_id lk_state lk_prio
7072   4119    1     1     0        0      1       1     0        1        
MTP3_LINK_SET_END
#----------------------------------------------------------------------------------
MTP3_ROUTE_START
#  ROUTE_TYPE Bitwise Usage:
# Bit  Value   Definition
#  Most Significant Bit   0/1 Destination is Route/CLUSTER Route
# Ist Bit     1/2 Direct/Indirect Route
#  DPC is a cluster if the route is a cluster route
MTP3_ROUTE
OPC    DPC  ROUTE_TYPE  LOG_LINKSET_ID   PRIORITY ROUTE_PARAM_LOG_ROUTE_ID
7072  4119    1         1                 1             1
7072  3031    2            1                 2             2
MTP3_ROUTE_END
#----------------------------------------------------------------------------------
#MTP3_PROVISIONING_END
#----------------------------------------------------------------------------------

#----------------------------------------------------------------------------------
#MTP2_PROVISIONING
#----------------------------------------------------------------------------------
#  number of MTP2 signaling links
MTP2_NUM_LINKS 1
#----------------------------------------------------------------------------------
# Configuration of MTP2 links:



Appendix

Dialogic® Diva® softSS7 for Windows Reference Guide page 36 

#
# MTP2_LOG_LINK_ID - MTP2 Link Id
# MTP2_ID          - MTP2 Id
# MTP2_CONTROLLER  - identifies the controller on which the link is set up
#                    (log-controller number)
# MTP2_TIMESLOT    - defines the timeslot of the link
# MTP2_MODE        - defines the MTP2 mode
#                    0 - normal mode
#                    1 - preventive mode
#----------------------------------------------------------------------------------
#MTP2_LOG_LINK_ID    MTP2_ID    MTP2_CONTROLLER   MTP2_TIMESLOT   MTP2_MODE
MTP2_LINK_CONFIG_START
 1                     0          1                 1            0
MTP2_LINK_CONFIG_END
#----------------------------------------------------------------------------------
#MTP2_PROVISIONING_END
#----------------------------------------------------------------------------------

ISUP: List of messages

Type Code ISUP: Message type

ACM 06 Address Complete

ANM 09 Answer

BLA 15 Blocking Acknowledgement

BLO 13 Blocking

CCR 11 Continuity Check Request

CFN 2F Confusion

CGB 18 Circuit Group Blocking

CGBA 1A Circuit Group Blocking Acknowledgement

CGU 19 Circuit Group Unblocking

CGUA 1B Circuit Group Unblocking Acknowledgement

CMC 1D Call Modification Completed

CMR 1C Call Modification Request

CMRJ 1E Call Modification Reject

CON 07 Connect

COT 05 Continuity

CPG 2C Call Progress

CQM 2A Circuit Group Query

CQR 2B Circuit Group Query Response

CRG 31 Charge information

DRS 27 Delayed Release

FAA 20 Facility Accepted

FAR 21 Facility Request

FOT 08 Forward Transfer

FRJ 1F Facility Reject

GRA 17 Circuit Group Reset Acknowledgement

GRS 29 Circuit Group Reset

IAM 01 Initial Address Message
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INF 04 Information

INR 03 Information Request

LPA 24 Loop Back Acknowledgement

OLM 30 Overload

PAM 28 Pass Along

REL 0C Release

RES 0E Resume

RLC 10 Release Complete

RSC 12 Reset Circuit

SAM 02 Subsequent Address Message

SUS 0D Suspend

UBA 16 Unblocking Acknowledgement

UBL 14 Unblocking

UCIC 2E Unequipped Circuit Identification Code

USR 2D User to User Information

0A Reserved

0B Reserved

0F Reserved

22 Reserved

23 Reserved

25 Reserved

26 Reserved
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